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          Twin Tec 
User Instructions for 
Twin Tuner P/N 16104 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR 

SALE OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES. 

OVERVIEW 
Twin Tuner P/N 16104 is for 2008-2013 H-D® 

touring models with the 73 pin Delphi® module and 
electronic throttle control. You can easily adjust your 
fuel injection to match the requirements of performance 
parts including camshafts, free flowing exhausts, and 
low restriction air filters. You can add or subtract fuel. 

Installation takes only 10-15 minutes and is very 
easy, with no splicing, cutting, crimping, or bulky 
interconnections. All access is at the Delphi ECM. Just 
remove four wires from the ECM connector, insert 
these wires into our small mating connectors, insert 
four new wires from the Twin Tuner into the ECM 
connector, and connect one ground wire. The unit is 
completely encapsulated and impervious to moisture. 
With a very low profile of only ½” and occupying a 
fraction of the space required by competitive products, 
you won’t have a problem finding a place to mount the 
unit.  

Figure 1 – Twin Tuner 

 

You can use the mode and up/down pushbutton 
switches to make fuel trim adjustments in the RPM and 
throttle position ranges required by most applications. 
The fuel trim value is displayed on a bright daylight 
readable LED display. The Twin Tuner also has an 
advanced mode, where you can use the optional USB 
interface and PC Link Tuner software to make precise 
fuel adjustments. You can make independent 
adjustments to the front and rear cylinders. 

  The Twin Tuner works great in combination 
with our Twin Scan II Plus tuning aid. You can directly 
export calculated fuel correction data to Twin Tuner 
data files. The system can be used for tuning on a 
dyno or under actual riding conditions on a closed 
course or race track. 

INSTALLATION 
1. If the motorcycle is equipped with a security 

system (TSSM module), make sure the system is 
disarmed. Turn off the ignition switch and 
disconnect the battery ground cable before 
proceeding. 

2. Find the Delphi® engine control module (ECM). 
The ECM is usually located under the seat. 

3. Unplug the ECM connector. Cut the cable tie that 
secures the wire conduit. Use a small flat 
screwdriver to depress the tabs on the side of the 
connector and remove the cable cover.  

4. Use a small flat screwdriver to gently slide out the 
green terminal retainer as shown in Figure 2.  

5. Refer to Table 1 for connection details. Remove 
four wires from the ECM connector. Terminal 
numbers are marked on the back side of the ECM 
connector. Original equipment wire color codes 
may vary. Note the color of each wire that you 
remove. We suggest that you mark up Table 1  
with any corrections for future reference.  

6. To release terminals, use the supplied plastic push 
pin as a terminal removal tool. Insert the push pin 
into the round hole between terminal cavities as 
shown in Figure 3. This will release the two 
adjacent terminals. Remove the appropriate 
terminal. Make sure that the adjacent terminal is 
not dislodged.  

7. Refer to Table 1 and install the four wires from the 
Twin Tuner into the ECM connector.  

8. Use a small side cutter to make a slit in the cable 
conduit so that the four wires you removed can 
exit.  Wrap electrical tape around the cable 
conduit. Reassemble the ECM connector. If the 
green retainer will not slide back into position, 
check for dislodged terminals and push them back 

http://www.daytona-twintec.com/
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up. Secure the cable conduit with a supplied cable 
tie. 

9. Refer to Figures 4-6. Use the supplied terminal 
insertion tool to insert the four terminals removed 
from the ECM connector into the two supplied soft 
rubber mini Sure-Seal connectors. To ease 
terminal insertion, first insert the tool into each 
connector cavity and rotate the tool several times 
to remove any rough spots. Lubricate the 
connectors and terminals with isopropyl alcohol 
(rubbing alcohol available at any pharmacy). Do 
not use other lubricants such as WD-40 as 
these will make the connector too slippery and 
you will not be able to hold it securely during 
the insertion process. Start by pushing a terminal 
into the connector by hand. Then use the insertion 
tool to push on the end of the terminal while 
slightly rotating the tool back and forth. Make sure 
each terminal is pushed in so that it is flush with 
the end of the connector as shown in Figure 6. If 
you push a terminal in too far or need to remove it, 
gently pull out on the wire.  

10. Mate the mini Sure-Seal connectors together and 
verify that the wire colors are correctly oriented as 
shown in Figure 4.  

Figure 2 – ECM Connector Retainer Removal 
and Terminal Numbering Detail 

 

 

 

Figure 3 – ECM Connector Terminal Removal 
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Figure 4 – Twin Tuner Wiring 

 

Figure 5 – Terminal Insertion 

 

 

Figure 6 – Terminal Insertion Detail 

 

 

Figure 7 – Completed Wiring at ECM 

 

 

Figure 8 – Completed Twin Tuner Installation 
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11. Connect the Twin Tuner black ground wire to an 
appropriate ground. You can generally find one or 
more screws used for other ground connections 
under the seat or near the ECM.  

12. The Twin Tuner brown wire with Weather Pack 
connector is the data link used for PC 
communications. If not used,  tape up this wire.  

13. Refer to Figure 8 for suggested Twin Tuner 
mounting location. You can use Velcro material to 
secure the unit. 

14. Reconnect the battery ground cable. Do not 
attempt to start the engine until you have 
completed the initial setup.   

 

 

 

 

 

CAUTION: Professional installation is 
recommended. The female Delphi 
Micro64 terminals are delicate and 
easily damaged. Replacement 
terminals are available as P/N           
829-15356827 from Mouser Electronics     
(1-800-346-6873 or www.mouser.com). 
The required Delphi crimping tool is 
P/N 15397700 available from Power & 
Signal Group (1-800-722-5273 or 
www.powerandsignal.com). A 
professional insertion tool for the mini 
Sure-Seal connectors is also available 
as P/N MSS-T-Tool from PEI Genesis 
(1-888-349-9787 or                      
www.pei-genesis.com).   

http://www.daytona-twintec.com/
http://www.mouser.com/
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Table 1 – Wiring Hookup 

Twin Tuner Wires 

Wire Color To ECM Connector  Signal 

Red 23 Rear Injector  

Orange 28 Front Injector 

Violet 37 Throttle Position Sensor 

White 72 Ignition Switch  

   

ECM Wires (removed from ECM connector) 

Wire Color (ECM terminal) To Mini Sure-Seal Plug Signal 

White/Black (72) 2A Ignition Switch 

Brown/Violet (37) 3A Throttle Position Sensor 

White/Yellow (28) 2B Front Injector 

Green/Gray (23) 3B Rear Injector 

 

INITIAL SETUP   
The Twin Tuner has a 10 position rotary mode 

switch used to select fuel trim parameters to edit, two 
digit LED display, and up/down pushbutton switches to 
change the parameter value. Fuel trim parameters are 
listed in Table 2. Note that the rectangular LED to the 
left of the two digit LED is illuminated for negative 
values. Values represent percent fuel trim. You can 
use a small flat screwdriver to rotate the mode switch. 
You can make parameter changes on-the-fly with the 
engine running.   

Before starting the engine for the first time, turn 
the ignition switch and run/stop switch on. The idle air 
control motor will move to the starting position and the 
fuel pump will be energized for several seconds, 
making an audible buzz. Set the mode switch from 
each position from 0 to 9. The LED display should be 
off in position 0. The LED display should illuminate and 
read 00 in positions 1-9 (unless your Twin Tuner has 
been preprogrammed for some specific application). If 
required, use the up/down pushbuttons to set the 
values for each position to zero. Start the engine and 
verify normal operation. If the engine will not start, or 
runs on one cylinder, recheck connections.  

 
 

 

 
 

BASIC TUNING   
Table 2 shows the engine operating ranges 

affected by fuel trim values in terms of RPM and 
throttle position sensor (TPS) values. For tuning 
recommendations and initial setup tables for common 
applications refer to the Appendix starting on page 11. 
For more details, please visit our Twin Tuner Tech 
FAQ at www.daytona-twintec.com/tech_tuner.html.  
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Table 2 – Mode Switch Settings 

Parameter Fuel Trim Operating Range 
0 Display off – used to prevent inadvertent changes during normal engine operation 

1 Idle 750-1250 RPM 0% TPS 

2 Low cruise 1250-2000 RPM 2.5-50% TPS 

3 High cruise 2000-3750 RPM 2.5-50% TPS 

4 Wide open throttle 1250-2000 RPM 50-100% TPS 

5 Wide open throttle 2000-2750 RPM 50-100% TPS 

6 Wide open throttle 2750-3750 RPM 50-100% TPS 

7 Wide open throttle 3750-4750 RPM 50-100% TPS 

8 Wide open throttle above 4750 RPM 50-100% TPS 

9 Acceleration enrichment (0 = none, 10 = maximum) 

 

ADVANCED TUNING   
The Twin Tuner also has an advanced mode, 

where you can use the optional USB interface and 
Windows software to check and observe system 
operation (Tuner Log) and make precise fuel 
adjustments (PC Link Tuner).  

PC REQUIREMENTS 
The Twin Tuner connects to your PC by means 

of an optional USB interface (P/N 18014) that is also 
used with our other engine controls. The PC must have 
a free USB port. If you have an older PC without USB 
capability, you cannot use the advanced tuning 
capability.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7. 
Data display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading.  

PC Link Tuner software includes print 
commands to print downloaded data. The program has 
been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 

reduces potential problems such as version conflicts 
and allows for application self-repair.  

There are two programs to install: Tuner Log and 
PC Link Tuner. Start by installing Tuner Log. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details. 

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in the 
Tuner_Log  folder on the CDROM or the setup.exe file 
downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 

Repeat the installation process for PC Link Tuner. 
Use the Windows Explorer or the Run command from 
the Windows Start Menu to launch setup.exe in the 
PC_Link_Tuner  folder on the CDROM or the setup.exe 
file downloaded from our website. InstallShield will install 
the software in an appropriate folder under Program 
Files. 

Once InstallShield has completed the 
installation, Tuner Log and PC Link Tuner will appear 
on the Windows Start Menu. You can then launch them 
just as you would any other Windows program.  

PC Link Tuner software requires the Monospace 
821 BT fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 

http://www.daytona-twintec.com/
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File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

TWIN TUNER CONNECTION  
Follow the instructions supplied with the optional 

USB interface to install the required USB drivers and 
configure the COM port. Once you have configured a 
COM port number for your new USB Interface, make 
sure that you use this same COM port selection in the 
Tuner Log and PC Link Tuner software. Use the 
“TC88A AND ALL OTHERS” switch setting. 

An adapter harness is supplied with the USB 
Interface for use with the Twin Tuner. Connect the 
alligator clip on the black wire to ground and the 
Packard Weather Pack connector to the mating 
connector on the brown wire from the Twin Tuner.  

Turn the ignition key and engine run/stop switch 
on to provide power to the system. Do not start the 
engine if you want to download or upload data with PC 
Link Tuner. 

TUNER LOG SOFTWARE 
When the engine is running, you can display real 

time engine data on an instrument panel type screen 
as shown in Figure 9 by using the View Real Time 
Data command on the View menu.  

You can also check proper operation of the 
throttle position sensor (TPS) when the run/stop switch 

is on (engine not running). Rotate the throttle through 
the full range of motion. The TPS% value should go 
from zero to 100%.   

Real time engine data is displayed on an 
instrument panel type layout with a round tach gauge 
and bar graph type gauges for all other parameters. 
Status messages are displayed in a separate window. 
If the engine is not running, most values will appear as 
zero or off. 

Displayed parameters include: 

RPM – engine crankshaft RPM (numeric value 
displayed beneath gauge) 

TPS – throttle position (0 to 100%) 

BAT – battery voltage 

FRONT INJ PW, REAR INJ PW – injector pulse 
width in milliseconds (pulse width commanded 
by ECM before fuel trim by Twin Tuner) 

FRONT FUEL%, REAR FUEL% – fuel trim in 
percent (0% means no change) 

STATUS – engine running status and basic 
mode (switch settings used to trim fuel) or 
advanced mode (PC Link Tuner tables used to 
trim fuel) 

http://www.daytona-twintec.com/
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Figure 9 – Real Time Engine Data Display 

 
 

PC LINK TUNER SOFTWARE 
Before the engine is started, you can download 

or upload data with PC Link Tuner.  

After PC Link Tuner is launched, the main 
screen appears blank. You have two options for 
obtaining data for editing. You can open a previously 
saved data file by using the Open File command on the 
File menu or you can download data from an attached 
Twin Tuner unit by using the Download Data From 
Twin Tuner command on the Communications menu. 
Note that Twin Tuner data files use a .dat extension. 
You should create a separate folder to store these 
files.   

Once you have Twin Tuner data, you can edit 
various 3D tables and parameters. 3D fuel trim tables 
are accompanied by chart displays that help visualize 
the data. You can also rotate the 3D chart display for a 
better view of a particular region. You can print the 
data associated with an active table or Twin Tuner 
parameters by using the appropriate Print command 
from the File menu. When you open a file or download 
data from a Twin Tuner, the data is stored in a buffer 
memory. After editing a table, you can save the edits to 
this buffer memory. Once you have completed all your 

edits, you can save the data in buffer memory to a file 
or upload it back to the Twin Tuner by using the 
appropriate command from the File or Communications 
menu. 

Please note that communication is only possible 
if the ignition key and run/stop switch are turned on 
and the engine has not yet been started.  

TWIN TUNER PARAMETERS  
Twin Tuner parameters shown in Figure 10 

control the overall operating mode of the unit and allow 
you to preset parameters without using the switches on 
the unit. Options and parameters that you can set 
include: 

Twin Tuner Version  – when a file is opened or 
data is downloaded, the software automatically 
determines the Twin Tuner version. Do not use EX 
version files or click on the EX option with the standard 
(race) Twin Tuner.  

Basic Mode – fuel trim values are based on 
switch settings. This is the default operating mode. 

Advanced Mode – fuel trim values are based 
on the 3D front and rear cylinder fuel trim tables.  

http://www.daytona-twintec.com/
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Injector Swap on Enrichment Mode – positive 
fuel trim is applied to the opposite injector to 
compensate for fuel distribution problems in some 
applications. This mode is not normally selected. Refer 
to tech support for additional details.  

Enable Manual Trim in Advanced Mode – this 
option is only available in advanced mode and is 
grayed out in basic mode. If this option is selected, 
switch settings 1 to 8 can be used to manually trim the 
3D fuel tables. If this option is not selected, switch 

settings 1 to 8 are ignored (switch setting 9 for 
acceleration enrichment is still active). 

Parameters 1-9 – display fuel trim parameter 
values. Can be used to edit or preset values without 
using the switches on the unit. Fuel trim parameters 
are listed in Table 2.   

User Data – you can enter up to 32 characters 
of user data that will be saved in EEPROM memory. 
User data can contain comments or serial numbers. 

Figure 10 – Twin Tuner Parameters 

 

EDITING 3D TABLE DATA  
You can edit the front and rear cylinder fuel trim 

tables. Before you can edit one of these tables you 
must either open a data file or download data from a 
Twin Tuner unit. Numeric data is always edited on the 
spreadsheet grid. The front and rear cylinder fuel trim 
tables are accompanied by 3D graphs that help 
visualize the data.  

Each table consists of 18 rows from 500 to 
6,500 RPM and 9 throttle position columns from 0% to 
100%. The 6,500 RPM value is used at all higher RPM 
levels. 

After you have edited a table, you must use the 
Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 

the Close Table command from the Edit menu, all your 
edits are lost.   

Front and Rear Cylinder Fuel Trim Tables 

The fuel trim values in these tables are only 
active if advanced mode is selected. You can enter fuel 
trim values from -20% to +30% in every cell. Unless 
you have specific experience in trimming individual 
cylinders and the associated fuel distribution problems, 
we suggest that you use the same values for both front 
and rear cylinders. You can edit a table for the front 
cylinder. After saving the table edits to buffer memory, 
you can use the Copy Front Cylinder Trim to Rear 
command from the Edit menu to quickly copy the entire 
table. 

http://www.daytona-twintec.com/


 

 
Daytona Twin Tec LLC, 240 Springview Commerce Drive - BLD 1 Suite J Debary, FL  32713                        16104 
(386) 304-0700   www.daytona-twintec.com 5/2020 

Page 10 

Figure 11 – Typical Front Cylinder Fuel Trim Table 

  
Editing Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 12.   

Figure 12 – Modify Command  

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import 3D table data 
to or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link Tuner program. In the PC Link 
Tuner program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 
menu. When you paste data into the PC Link Tuner 
program, the data is automatically checked and any 
out-of-range data corrected.  

Chart Operations 

You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link Tuner is intended to be an open system 
and uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link Tuner.  

http://www.daytona-twintec.com/
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ELECTRONIC THROTTLE CONTROL 
ISSUES 

All 2008 and later touring models have a throttle 
control actuator (TCA) that also controls idle air. 
Throttle position (TPS) refers to the  position of the 
throttle plate in the TCA, not the twist grip sensor. nder 
warm idle conditions, scan tools will show TPS at 
about 5% (the value will be higher when the engine is 
cold). The Twin Tuner subtracts 5% from the actual 
TPS value. Under warm idle conditions, the Tuner Log 
software will show zero TPS and the Twin Tuner will 
operate in the zero TPS and 1000 RPM cell. A similar 
convention (to subtract 5% from the actual TPS value 
and report warm idle as zero TPS) is also used by 
other systems. 

http://www.daytona-twintec.com/
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APPENDIX – INITIAL SETTINGS 
Use the flow chart to select the best initial 

settings for your application. The Twin Tuner series is 
appropriate for most Stage 1 (low restriction air filter 
and free flowing exhaust) and Stage 2 (performance 
camshafts) applications. For Stage 3 (increased 
displacement, high compression pistons, and ported 
heads), we recommend the Twin Tuner II series.  

2006 fuel injected Dyna® and all 2007 and later 
Harley-Davidson® models are equipped with dual 
narrow-band oxygen sensors and a Delphi® ECM that 
supports closed loop air/fuel ratio (AFR) control based 
on feedback from the sensors. After the engine has 
warmed up, the ECM will maintain the AFR at 14.6 
during idle and part throttle cruise. While the ECM is in 

closed loop operation, you cannot change the AFR at 
idle and part throttle cruise by adding fuel with the Twin 
Tuner. The ECM will correct for any attempt to add fuel 
in these operating ranges.  

If the motorcycle has Stage 1 (low restriction air 
filter and free flowing exhaust) or Stage 2 (mild 
performance camshafts) modifications, the ECM can 
generally make the required fuel changes at idle and 
part throttle cruise based on closed loop feedback from 
the oxygen sensors. You can use the Twin Tuner to 
add fuel at wide open throttle. For more details, please 
visit our Twin Tuner Tech FAQ at www.daytona-
twintec.com/tech_tuner.html. 
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No Original Equipment Oxygen Sensors

Parameter Fuel Trim Operating Range Stage 1 Mods Stage 2 Mods
0 Display Off

1 Idle 750-1250 RPM 0% TPS 0 -5

2 Low cruise 1250-2000 RPM 2.5-50% TPS 5 10

3 High cruise 2000-3750 RPM 2.5-50% TPS 5 10

4 Wide open throttle 1250-2000 RPM 50-100% TPS 10 20

5 Wide open throttle 2000-2750 RPM 50-100% TPS 10 20

6 Wide open throttle 2750-3750 RPM 50-100% TPS 10 20

7 Wide open throttle 3750-4750 RPM 50-100% TPS 10 20

8 Wide open throttle above 4750 RPM 50-100% TPS 10 20

9 Acceleration enrichment 4 5

1. These values will result in a slightly rich initial setup that should be safe for most applications.

2. Refer to the Twin Tuner Tech FAQ for further tuning suggestions.

Notes: 

Table A - Twin Tuner Settings 

 
 

 

Parameter Fuel Trim Operating Range Stage 1 Mods Stage 2 Mods
0 Display Off

1 Idle 750-1250 RPM 0% TPS 0 -5

2 Low cruise 1250-2000 RPM 2.5-50% TPS 0 5

3 High cruise 2000-3750 RPM 2.5-50% TPS 0 5

4 Wide open throttle 1250-2000 RPM 50-100% TPS 10 20

5 Wide open throttle 2000-2750 RPM 50-100% TPS 10 20

6 Wide open throttle 2750-3750 RPM 50-100% TPS 10 20

7 Wide open throttle 3750-4750 RPM 50-100% TPS 10 20

8 Wide open throttle above 4750 RPM 50-100% TPS 10 20

9 Acceleration enrichment 4 5

Notes: 

1. These values will result in a slightly rich initial setup that should be safe for most applications.

2. Refer to the Twin Tuner Tech FAQ for further tuning suggestions.

Table B - Twin Tuner Settings 
Original Equipment Oxygen Sensors Installed
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Use the recommended setup table as a starting 
point for further tuning. If you have access to a dyno 
with an exhaust sniffer, refer to the following section for 
more guidelines. If you do not have access to a dyno, 
you can still make some adjustments based on the 
following guidelines: 

1. Aftermarket camshafts will generally increase 
manifold pressure (reduce vacuum) near idle. The 
Delphi® speed-density control will compensate 
with excessive fuel resulting in a very rich idle. If 
the idle still seems rich after using the 
recommended settings, try further reducing the 
idle fuel in -5% steps.  

2. If the engine still runs rough or coughs (backfire 
through the intake) under part throttle cruise 
conditions, try adding an additional 5-10% fuel in 
the RPM ranges where problems are noted.  

3. Performance modifications will generally increase 
the fuel requirement at wide open throttle. If the 
engine still runs rough or hesitates at wide open 
throttle, try adding 5-10% fuel in the RPM ranges 
where problems are noted. 

4. If throttle roll-on response is poor, try using a 
higher value for acceleration enrichment. 

 

If you have access to a load control dyno with an 
exhaust sniffer, you are in a much better position to 
make accurate adjustments. Skip steps 1-2 for models 
with oxygen sensors since the ECM can generally 
make the required fuel changes at idle and part throttle 
cruise based on closed loop feedback from the oxygen 
sensors (refer to following sections for more details 
about oxygen sensor equipped models). 

1. Make sure the engine is fully warmed up and has 
reached normal operating temperature. Run the 
engine at idle. Trim the idle fuel, while observing 
the air/fuel ratio (AFR). Idle AFR should be near 
13.5. Very few applications will require adding fuel 
at idle. Aftermarket camshafts will generally 
increase manifold pressure (reduce vacuum) near 
idle. The Delphi® speed-density control will 
compensate with excessive fuel resulting in a very 
rich idle. If the idle AFR is still rich after using the 
recommended settings, try further reducing the 
idle fuel in -5% steps. If you are using sniffer, 
obtaining an accurate idle AFR reading may be 
difficult due to reversion effects. Reversion will 
result in a false lean AFR reading. If the AFR 
reading is above 14.6 before fuel trim, but the 
engine is running reasonably well, you probably 
have a false lean reading.  

2. Run the engine at part throttle near the middle of 
the RPM and throttle position ranges for low and 
high cruise. Trim the fuel so that average AFR 
readings are near 13.8. If you observe a lean spot 
where AFR exceeds 14.6, add more fuel. You are 
always better off with the engine running rich in 
some areas than coughing in one particular lean 
spot.  

3. Performance modifications will generally increase 
the fuel requirement at wide open throttle. 
However, it is not unusual for some 2-into-1 
exhaust systems to have a torque dip at some 
RPM point where the engine then runs very rich 
and fuel must be subtracted. Do wide open throttle 
runs and record AFR values. Target AFR values 
at wide open throttle are in the 12.8-13.0 range. 
Make appropriate fuel trim adjustments in each 
RPM range. High compression engines may 
exhibit spark knock at wide open throttle. Spark 
knock can often be eliminated by adding more fuel 
(AFR in the 12.0-12.5 range) within the affected 
RPM range.   

4. If throttle roll-on response is poor or a lean 
transient (high AFR values) is observed, try using 
a higher value for acceleration enrichment.   

Decel Popping 

Decel popping is sometimes encountered with 
open type exhaust systems without restrictive baffling. 
The solution involves modifying fuel values at closed 
throttle above the idle RPM range and requires use of 
our USB interface and PC Link Tuner software. For 
more details, please visit our Twin Tuner Tech FAQ at 
www.daytona-twintec.com/tech_tuner.html. 
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